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NEW QUESTION 1
You have the following tables.

There is a relationship between the tables.
You need to create a measure that displays how many users have a total TimeInMinutes that is greater than 60. How should you complete the DAX formula? To
answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 2
You use a workbook query to import a table named Customers that contains a column named CustomerName. CustomerName has names in the format of
Lastname, Firstname.
You need the CustomerName column to contain names in the format of Firstname Lastname. A space must separate Firstname and Lastname.
Which two commands should you use? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 Split Column By Delimiter
 Merge Columns

https://support.office.com/en-us/article/split-a-column-of-text-power-query-5282d425-6dd 0-46ca-95bf-8e0da9539662
https://support.office.com/en-us/article/merge-columns-power-query-80ec9e1e-1eb6-4048-b500-d5d42d9f0

NEW QUESTION 3
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Queryl that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.
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You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You select the UserName and Location columns, and then you click Keep Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 4
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, white others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Query1 that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved t]y the query is shown in the following table.

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You select the-UserName and Location columns, and then you click Remove Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 5
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.
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End of repeated scenario.
You have a PivotChart that uses Manufacturer as the axis and the sum of SalesAmount as the values. You need to ensure that only the top 10 manufactures
appear in the chart.
What should you do?

A. Change the format of the SalesAmount field.
B. Create a calculated column.
C. Configure the Value Filters.
D. Summarize the SaleAmount field by Max.

Answer: C

Explanation: 
https://www.extendoffice.com/documents/excel/1963-excel-pivot-table-filter-top-10.html 

NEW QUESTION 6
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server database and loads data to the
data model. You create a PivotTable and a PivotChart.
You plan to share SalesResults.xlsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Run the Document Inspector.
B. Save the workbook as an Excel Binary Workbook (.xlsb).
C. From Query Editor, open the Data Source Settings and delete the credentials.
D. Modify the source of the query.

Answer: C

NEW QUESTION 7
Your company has a data analyst who uses Microsoft Power BI Desktop to create a data model and several reports.
The data analyst publishes the reports to the Power BI service.
You need to create a PivotTable in Excel that uses the data model created by the data analyst. The solution must prevent the data from being imported into Excel.
What should you do first?

A. From powerbt.com, select the repor
B. From the File menu, click Save as.
C. From Excel, create a new query that uses the Data Catalog.
D. From powerbi.com, select the report From the File menu, click Download report.
E. From powerbi.com, select the report and click Analyze in Excel.

Answer: D

NEW QUESTION 8
You create the PivotChart shown in the exhibit. (Click the Exhibit button.) Exhibit:
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In which area is Product and in which area is SalesAmount? To answer, drag the appropriate fields to the correct areas. Each field may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: Product: Axis
Box 2: SalesAmount: Values

NEW QUESTION 9
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You create the column chart shown in the Pivot Chart exhibit. (Click the Exhibit button.)

You need to ensure that the month axis is displayed chronologically. What should you do?

A. In the model, configure the Sort By Column setting for [Month] as [MonthID].
B. In the model, configure the Sort By Column setting for (Month) as [Date].
C. In PivotTable Fields, add [MonthID] to the Legend area.
D. In PivotTable Fields, add [Date] to the Legend area.

Answer: B

NEW QUESTION 10
You have an Excel workbook that contains a table named Sales. You add Sales to the Power Pivot model.
You need to set a column named TransactionID as the row identifier for the Sales table. What should you do?

A. From Power Pivot, modify the Table Behavior setting.
B. From Query Editor, add an index column.
C. From Query Editor, modify the Data Type.
D. From Power Pivot, modify the Default Field Set.

Answer: A

Explanation: 
https://msdn.microsoft.com/en-us/library/hh560542(v=sql.110).aspx

 In the Data View of your PowerPivot Window, click the PowerPivot Window: Advanced Tab.
 Click the table tab at the bottom of the window to select the table for which you are configuring

properties.
 In Reporting Properties, click Table Behavior.
 Set the Row Identifier, and then proceed to specify other properties in this dialog.

Opening the Table Behavior dialog box https://ksdconsultancy.blog/2015/10/08/set-table-behaviour-in-powerpivot/

NEW QUESTION 10
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, white others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Quety1 that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved by the query is shown in the following table.
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You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You sort the UserName column in ascending order. You select the UserName column, and then you click Remove Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 13
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
Your company has sales offices in several cities.
You create a table that represents the amount of sales in each city by month as shown in the exhibit.

You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You modify the conditional formatting rule, and then set a new value for the yellow icon. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 18
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the following data.

You need to retrieve a list of the unique ProductName entries.
Solution: Open the Advanced Filter dialog box, select Filter the list, in-place, and then select Unique records only.
Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 22
You have an Excel workbook query that loads data to a worksheet and the data model. You need to ensure that the data is refreshed whenever you open the
workbook.
What should you do?
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A. From the File tab, click Option, and then modify the Data option.
B. From the File tab, click Options, and then modify the General options.
C. From the Data tab, click Queries & Connections, and then edit the properties of the query.
D. From the Power Pivot model, modify the Table Behavior setting.

Answer: C

Explanation: 
https://support.office.com/en-us/article/refresh-an-external-data-connection-in-excel-2016-for-windows-152417

NEW QUESTION 23
Note: This question is part of a series of questions that use the same scenario, For your convenience is repeated in each question. Each question presents a
different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit.
Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM [Sales], DATESMTD
The following sample formula creates a measure that calculates the 'Month To Date Total' for the Internet sales.
To see how this works, create a PivotTable and add the fields, CalendarYear, MonthNumberOfYear and
DayNumberOfMonth, to the Row Labels
area of the PivotTable. Then add a measure, namedMonth To Date
Total, using the formula defined in the code section, to the Values
area of the PivotTable.
=CALCULATE(SUM(InternetSales_USD[SalesAmount_USD]), DATESMTD(DateTime[DateKey])) https://msdn.microsoft.com/en-us/query-bi/dax/datesmtd-
function-dax

NEW QUESTION 25
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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Solution: You create a hierarchy named Products that contains ProductCategory,
Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag
Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 29
Note: This question is part of a series of questions that use the same scenario, For your convenience the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.

The data model is shown in the Data Model exhibit.
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The tables in the model contain the following data:
DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or
revenue are recorded for that day. Total Hours and Total Revenue are two measures defined in DailyRepairs. Total Hours sums the Hours column, and Total
Revenue sums the Revenue column.
Workshops has a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always Firstname
Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
RepairTypes has a list of alt the repair types. Dates has a list of dates from 2015 to 2018. End of repeated scenario.
You plan to analyze The average revenue per hour by combinations of day, repair type, and workshop name. You need to create a measure to support the
planned analysis.
Which DAX formula should you use? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
DIVIDE ([Total Revenue ],[ Total Hours], BLANK())

NEW QUESTION 33
You need to configure a PivotChart as shown in the following exhibit.

Witch chart element should you enable?

A. Data Labels
B. Axis Titles
C. Data Table
D. Error Bars

Answer: B

NEW QUESTION 34
You have the following table.
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You plan to use [Month Name] as the axis in a PivotChart.
You need to ensure that whenever [Month Name] is used in a chart, the months are displayed chronologically be default.
What should you do?

A. Sort the [Month Name] column by [Month Name].
B. Change the Data Type of [Month Name] to Date.
C. Sort the [Month Name] column by [Month Name].
D. Add a calculated column named [ID] that use the [Month Name] & [Month Number] DAX formula

Answer: D

Explanation: 
References:
https://gasperkamensek.wordpress.com/2013/04/16/sorting-months-chronologically-and-not-alphabetically-in-a-

NEW QUESTION 38
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
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 Workshops have a list of all the workshops and the current and previous workshop managers. The
format of the Workshop Manager column is always Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the
record is the current workshop manager.

 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You need to add a custom column to the workbook query for Workshops that contains the email address of the workshop manager. The format of the email
address is firstname.lastname@contoso.com.
How should you complete the query from Query Editor? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text.Replace([Workshop Manager]," ",".")&Contoso.com

NEW QUESTION 42
You have a measure that is used by a KPI.
You need to display the output of the measure in a cell in your workbook. Which Excel function should you use?

A. CUBEVALUE
B. VLOOKUP
C. CUBESET
D. LOOKUP

Answer: A

Explanation: 
https://support.office.com/en-us/article/cubevalue-function-8733da24-26d1-4e34-9b3a-84a8f00dcbe0 https://powerpivotpro.com/2010/06/using-excel-cube-
functions-with-powerpivot/

NEW QUESTION 45
You open an Excel worksheet as shown in the following exhibit.
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You need to export the data into a dataset in the Microsoft Power BI service. What should you do first?

A. Save the tile as an Excel template.
B. Select the data, and then insert a table.
C. Select the data, and Then insert a PivotTable.
D. Install Power BI Publisher for Excel.

Answer: D

NEW QUESTION 49
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheet. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.

End of repeated scenario.
You need to create a measure named [Sales Monthly RT] that calculates a running total of [Sales] for each date within a month as shown in the following exhibit.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([Sales],DATESMTD(DimDate[Date])) CALCULATE(SUM([Sales],DATESMTD(DimDate[Date])))

NEW QUESTION 54
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.?

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName. Solution: You create a measure that uses the
USERELATIONSHIP DAX function.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 59
You have an Excel workbook that displays two PivotCharts. One chart displays sales by month. The other chart displays sales by year.
You add a slicer for month.
You discover that when you select a month in the slicer, the data in the sales by year PivotChart changes. You need to prevent the slicer from affecting the sales
by year PivotChart.
What should you do?

A. Remove all the fields from the Filters area of the sales by month PivotChart.
B. Modify the Value Field Settings for the values of the sales by year PivotChart,
C. Modify the Report Connections of the slicer.
D. Remove all the fields from the Filters area of the sales by year PivotChart.

Answer: C

NEW QUESTION 64
You have a data model that has the following tables.
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You create a PivotTable. The data displayed in the PivotTable is shown in the following table.

You need to ensure that the correct data is displayed. What should you do?

A. Modify the workbook connections
B. Configure the PivotTable Options
C. Modify the relationships
D. Refresh the data connection

Answer: C

NEW QUESTION 69
You have an Excel workbook that has the following two workbook queries:
A query named consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
A query named employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database
Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table. Which command should you use?

A. Transpose
B. Append Queries
C. Merge Queries
D. Combine Binaries

Answer: B

Explanation: 
Append is similar to UNION ALL in T-SQL.
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

NEW QUESTION 72
You have the PivotTable shown in the following exhibit.

You need to display only rows in the PivotTable in which the sum of LineTotal is greater than 100. What should you do?

A. From Row Label, configure a Label filter.
B. Add a slicer for LineTotal and select the values from the slicer.
C. From Row Label, configure a Value Filter.
D. Add LineTotal to the Filters area of PivotTable Field
E. Configure the Filters value.
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Answer: B

NEW QUESTION 75
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You need to create a PivotChart that displays the month, the hours of the month, and the hours of the previous month, as shown in the following exhibit.

Which DAX formula should you use for the Total Hours Last Month measure? To answer, drag the appropriate fields to the correct targets. Each value may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered
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Answer: A

Explanation: 
IF (ISBLANK[(Total Hours]),BLANK(), CALCULATE([total Hours], DATEADD(tblDates(Date),
-1,MONTH)))

NEW QUESTION 80
You create a PivotTable and a Pivot Chart as shown in the following exhibit.

You need to decrease the number of columns in the PivotChart to six. What should you do?

A. Right-click the PivotChart, click Format Axis, and then change Interval between marks to 2.
B. Right-click the PivotTable, click Group, and then change By from 10 to 20.
C. Right-click the PivotChart, click Select Data, and then remove five of the bins from the Horizontal (Category) Axis Labels.
D. Change the chart type to Histogram.

Answer: B

NEW QUESTION 83
Your company has sales offices in several cities.
You create a table that represents the amount of sales in each city by month as shown in the exhibit.

You need to ensure that all values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You create a measure, and then define a target value. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 85
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer chokes, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.
Data Sample exhibit:

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full 70-779 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/70-779-exam-dumps.html (117 New Questions)

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot generates the following error message: “The relationship cannot be
created because each column contains duplicate values. Select at least one column that contains only unique values”.
You need to ensure that you can create a valid relationship between the tables. What should you do?

A. In the Power Pivot model, change the data type for Workshop[ID] to General
B. In the workbook query for Workshops, add an index column
C. In the Power Pivot model, change the Table Behavior setting for Workshops
D. In the workbook query for Workshops, filter [IsLatest] to equal 1

Answer: C

Explanation: 
References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx

NEW QUESTION 90
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:
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The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
To the Dates table, you need to add a calculated column named Months Ago. Months Ago must display the number of calendar months before the current month.
For example, if the current date is July 10, 2017, the Value of Months Ago will be 0 for all the dates in July 2017, 1 for all the dates in June 2017, and 2 for all the
dates in May 2017.
How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: MONTH
Box 2: TODAY
References:
https://msdn.microsoft.com/en-us/library/ee634914.aspx https://msdn.microsoft.com/en-us/library/ee634567.aspx https://msdn.microsoft.com/en-
us/library/ee634554.aspx

NEW QUESTION 93
You create a new workbook and add a table to a data model. The data is shown in the following table.
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You need to create a visualization as shown in the following exhibit.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
 Create a Pivot Table. Create a measure.
Create a Power View Report

NEW QUESTION 94
You have 12 sales reports stored in a folder as CSV files. Each report represents one month of sales data for a year. The reports have the same structure.
You need to analyze the entire year of sales data.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Click From CSV, and then select the first file in the folder. Edit the query, and then click Append Queries.
From the Power Pivot tab, click Add to Data Model.

NEW QUESTION 97
You have a workbook query that loads data from a table in a Microsoft Azure SQL database. The table has a column named LineTotal. The following is a sample
of the data in LineTotal:
• 40
• 1
• 999
• 7658
• 883432
You need to ensure that when you load the data to the model, LineTotal is set as currency. What should you do from Query Editor?
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A. Configure the Data Type
B. Round the column.
C. Split the column by characters.
D. Split the column by delimiter.

Answer: A

NEW QUESTION 102
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Exhibit:

Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You plan to use the DAX time intelligence functions of DATEADD and DATESMTD. You need to ensure that the functions return the correct data.
What should you do first?

A. Delete and recreate the relationship between FactSales and DimDate.
B. Change the Data Type of FactSales[DateKey].
C. Mark DimDate as the date table.
D. Change trie Data Type of DimDate[DateKey].

Answer: C

Explanation: 
https://docs.microsoft.com/en-us/sql/analysis-services/lesson-3-mark-as-date-table?view=sql-analysis-services-2

NEW QUESTION 105
You have a query that retrieves customers and their locations. You have sample of the data as shown in the following table.

Additional customers and locations are added frequently.
You need to transform the data as shown in the following table.
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What should you do?

A. Select the Locations columns and the select split column by delimite
B. Use a comma as the delimiter and split into rows.
C. Select the Customer columns, and then click Unpivot Columns.
D. Select the Customer columns, and then click Unpivot other Columns.
E. Select the Location columns and then select split column by delimite
F. Use a comma as the delimiter and split into columns.

Answer: A

NEW QUESTION 109
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

Your company has 100 products subcategories and more than 10,000 products. End of repeated scenario.
You need to create a chart as shown in the following exhibit.
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Which field should you use for each area? To answer, drag the appropriate field to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Axis: Month Year Legend: Channel Name Values: SalesAmount

NEW QUESTION 113
You have the following table named SalesOrder Detail in a model.

You need to calculate the sum of SalesTotal for all the rows that have a quantity greater than 1.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
CALCULATE(SUMX(‘SalesOrdersDetail’[SalesTotal]),‘SalesOrderDetail’[Quantity] > 1)

NEW QUESTION 115
You add two tables named Date and Invoices to a data model, Invoices contains a column named InvoiceDate that has a Data Type of Date, Date contains a
column named DateID that has a Data Type of which Number. DateID is in the format of YYYYMMDD.
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You need to create a relationship between Date and Invoices. What should you do first?

A. Change the Data Type of InvoiceDate and DateID to Text.
B. Create a measure in Invoices that uses the Format DAX Function.
C. Change the Data Type of DateID to Date.
D. Create a calculated column in Invoices that uses the Format DAX function.

Answer: C

Explanation: 
https://support.office.com/en-us/article/data-types-in-data-models-e2388f62-6122-4e2b-bcad-053e3da9ba90?ui= 

NEW QUESTION 119
You have a query that retrieves the following data.

You need to configure the query to ensure that the data appears as shown in the following table.

What should you do?

A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation
C. Unpivot the table on the Vendor_ID column
D. Pivot the table on the Vendor_ID column

Answer: B

NEW QUESTION 121
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1, but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
solution must maintain the existing
transformations.
Solution: From Query Editor, you configure the Data source settings. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 124
You have a workbook query that loads the following table

You pivot the table on the Key column by using Value as the values column, and you receive the results shown in the following table.
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You need to ensure that the data appears as shown in the following table.

What should you do?

A. Change the aggregate value function of the pivot.
B. Select the ID column, and then click Unpivot Columns
C. Change the Data Type of the Value column.
D. Delete the Picoted Column ste
E. Select the Key column, and the click UnpivotColumns.

Answer: B

Explanation: 
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098

NEW QUESTION 125
You have a workbook query that retrieves data from a table named Users. Users contains a column named PhoneNumber. The following is a sample of the data in
PhoneNumber.
514 555 0169
1 (11) 500 555-0122
128 555-0148
819 555-0186
1-996-555-0192
+1 138-555-0156
556-555-0192
You need to create a custom column that contains the data in PhoneNumber in the format of 999-999-9999. The following is a sample of the desired data.
514-555-0160
500-555-0122
128-555-0148
819-555-0186
996-555-0192
138-555-0156
556-555-0192
How should you complete the Query Editor formula? To answer, drag the appropriate values to the correct targets. Each value may be used once, more than once,
or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Text.Replace(Text.End([Phone],12)," ","-")
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NEW QUESTION 130
You have two visualizations as shown in the following exhibit.

Use the drop-down menus to select the answer choice that completes each statement based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 132
You create an Excel workbook named SalesResults.xlsx. You create a workbook query that connects to a Microsoft SQL Server Database and loads data to the
data model. You create a PivotTable and PivotChart.
You plane to share SalesResults.slsx to several users outside of your organization.
You need to ensure that the users can see the PivotTable and the PivotChart when they open the file. The data in the model must be removed.
What should you do?

A. Modify the source of the query.
B. From Query Editor, open the Data Source Setting and delete the credentials.
C. Run the Document inspector.
D. Save the workbook as an Excel Binary Workbook (xlsx)

Answer: A

Explanation: 
References:
https://support.office.com/en-us/article/data-source-settings-power-query-9f24a631-f7eb-4729-88dd-6a4921380

NEW QUESTION 136
You have a Power Pivot data model that contains a table named DimProduct DimProduct has seven columns named ProductKey, ProductLabel, ProductName,
ProductDescription, ProductSubCategoryKey, Manufacturer, and Brand.
Only the members of the product team use all the data in the DimProduct table.
You need to simplify the model for other users by hiding all the columns except ProductName. What should you do?

A. Create a perspective that has only the ProductName field from DimProduct selected.
B. Select all the columns in DimProduct except ProductName, right-click the columns, and then click Hide from Client Tools.
C. Edit the Default Field Set for DimProduct and add ProductName to the Default Field.
D. Edit the Table Behavior settings for DimProduct and add ProductName to the Default Label.

Answer: B

Explanation: 
https://support.office.com/en-us/article/hide-columns-and-tables-in-power-pivot-ddf5b1f2-2ed2-4bdb-8f78-6f94

NEW QUESTION 140
You have the following tables in a data model.
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You create a PivotTable to display SaleAmount by Month. A sample of the results are shown in the following table.

A. In the data model, modify the Sort By Column setting for Date[Month Year].
B. From PivotTable Fields, add Date[Year] to the Rows area.
C. In the data model, modify the Sort by Column setting for Sales[Date].
D. From PivotTable Fields, modify the Field Settings for DatelMonth Year].

Answer: C

NEW QUESTION 143
You have two queries named Client and Invoices. A sample of Client is shown in the following table.

A sample of Invoices is shown in the following table.

You need to create a new table that has the following information.

Which join kind should you use?

A. Inner
B. Left Outer
C. Right Anti
D. Left Anti

Answer: B

Explanation: 
https://www.excelguru.ca/blog/2015/12/16/merge-tables-using-outer-joins-in-power-query/

NEW QUESTION 145
You have a table named Sales that has three columns named Region, Country, and SalesAmount. You create a PivotTable as shown in the following exhibit.

You need to ensure that the PivotTable appears in three columns as shown in the following exhibit.
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What should you do?

A. On the Design tab, click Report Layout and then click Show in Compact Form.
B. Move Country from the Rows area to the Columns area.
C. Move Country from the Rows area to the Values area.
D. On the Design tab, click Report Layout and then click Show in Tabular Form.

Answer: D

NEW QUESTION 148
You have a data model that contains a table named SalesOrders has four columns named Orderld, SalesAmount, OrderDate, and Territory.
You plan to create a PivotChart that will display the percentage of SalesAmount for each Territory. You need to create a measure to calculate the percentage of
sales of each territory.
How should you complete the DAX formula? To answer, drag the appropriate value to the correct targets. Each value may be used once, more than once, or not at
all. You need to drag the split bar between panes or scroll to view content.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
SUM([SalesAmount) / ALL(SalesOrders) /(FILTER , ALL(SalesOrders))

NEW QUESTION 151
You have an Excel spreadsheet that contains a PivotChart. You install Microsoft Power BI Publisher for Excel.
You need to add a tile for the PivotChart to a Power BI dashboard. What should you do?

A. From the Power BI tab in Excel, click Pin.
B. From the File menu in Excel, click Publish.
C. From powerbi.com, upload the excel workbook.
D. From powerbi.com, click Get apps.

Answer: A

NEW QUESTION 155
You have a data model in Excel.
You export the data and the data model into a dataset in the Microsoft Power BI service. What can you use to modify the data model that is published to the Power
BI service?

A. Microsoft Power BI Desktop
B. Excel and the Microsoft Power BI service
C. Excel only
D. the Microsoft Power BI service only

Answer: A

NEW QUESTION 157
You have a workbook query that uses an Excel data source. The data source contains the following table.
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You need the data to appear as shown in the following table.

How should you transform the data from Query Editor? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: User and UserID Box 2: Unpivot Columns
References:
https://support.office.com/en-us/article/unpivot-columns-power-query-0f7bad4b-9ea1-49c1-9d95-f588221c7098

NEW QUESTION 158
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName.
Solution: You create a measure that uses the ISCROSSFILTERED DAX function Does this meet the goal?

A. Yes
B. No

Answer: B

Passing Certification Exams Made Easy visit - https://www.surepassexam.com



Recommend!! Get the Full 70-779 dumps in VCE and PDF From SurePassExam
https://www.surepassexam.com/70-779-exam-dumps.html (117 New Questions)

NEW QUESTION 161
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions
will not appear in the review screen. You have the following data.

You need to retrieve a list of the unique ProductName entries.
Solution: Create a PivotTable that uses the ProductName field in the Values area. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 164
......
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